Langkah-Langkah Komprehensif Menyusun Buku
Menggunakan NotebookLM dan Gemini

Menulis sebuah buku atau artikel merupakan tugas yang kompleks, seringkali
melibatkan tantangan dalam mengelola riset, menyusun ide, dan menyempurnakan
narasi. Namun, dengan integrasi alat bantu digital bertenaga kecerdasan buatan (Al)
seperti NotebookLM dan Gemini, proses ini dapat diubah menjadi lebih terstruktur,
efisien, dan produktif. Laporan ini akan menguraikan langkah-langkah detail untuk
memanfaatkan kemampuan Al dalam setiap fase penulisan, mulai dari pengumpulan
referensi hingga finalisasi naskah.

Kerangka langkah-langkah menyusun buku atau artikel:

1. Menentukan judul atau tema,

2. Menentukan atau mencari dan mendapatkan referensi baik buku atau jurnal sesuai
dengan judul atau tema yang ditentukan,

3. Mengupload semua file referensi melalui NotebookLM
(https://notebooklm.google.com/),

4. Membuat artikel/deskripsi pendek sesuai judul atau tema yang ditentukan
menggunakan teks prompt yang sesuai. Baca artikel sebelumnya dalam penggunaan
teks prompt di NotebookLM,

5. Meng-copy output darii NotebookLM untuk dijadikan input teks prompt pada Gemini
(https://gemini.google.com/)

6. Menempelkan (paste) teks dari output NotebookLM di Gemini, kemudian tuliskan
teks prompt yang sesuai agar dapat menghasilkan output yang tepat. Baca artikel
sebelumnya dalam penggunaan teks prompt di Gemini,

7. Jika akan membuat buku dengan daftar referensi yang lengkap maka PILIH FITUR
DEEP RESEARCH, tetapi jika hanya akan membuat artikel tanpa daftar referensi yang
menyertai maka TIDAK PERLU pilih fitur DEEP RESEARCH,

8. Jika sudah selesai maka tinggal pilih Ekspor ke Dokumen (Export to Docs) untuk edit
di Google docs,

9. Selesai edit maka pilih menu File > Download: Docs atau PDF

10. Di Ms Words dapat dilakukan editing ulang, lalu layouting -> siap printing, langkah 10
ini termasuk langkah yang lebih lama.




Bagian 1: Fondasi Riset dengan NotebookLM

1. Menentukan Judul atau Tema

Langkah awal yang krusial dalam menyusun sebuah buku adalah menentukan judul
atau tema yang jelas. Penetapan ini berfungsi sebagai kompas yang memandu seluruh
proses penulisan, mulai dari pengumpulan referensi hingga pengembangan narasi.
Judul atau tema yang spesifik akan membantu memfokuskan upaya riset dan
memastikan bahwa semua materi yang dikumpulkan relevan dengan tujuan akhir buku.
Tanpa fondasi yang kokoh ini, proses penulisan dapat menjadi tidak terarah dan
kurang efisien.

2. Mengumpulkan Referensi

Pengumpulan referensi merupakan tulang punggung setiap karya tulis yang
komprehensif. Dalam era digital, ketersediaan berbagai format materi riset menuntut
pendekatan yang adaptif. NotebookLM dirancang untuk memfasilitasi pengumpulan
materi riset yang beragam dan berkualitas tinggi dengan kemampuannya menangani
berbagai format konten dalam satu ruang kerja terpadu.’

Strategi untuk mengumpulkan materi riset yang beragam dan berkualitas tinggi
meliputi:

e Mengumpulkan Materi Proyek Komprehensif: Pendekatan yang efektif adalah
mengumpulkan berbagai artefak proyek yang autentik, bahkan yang mungkin
terlihat "berantakan." Ini bisa mencakup tangkapan layar postingan media sosial
positif dari klien, pertukaran email, tinjauan audio kasar dari pekerjaan yang
dilakukan, catatan tulisan tangan, dan dokumentasi lain yang menangkap
perkembangan dan hasil proyek." Pendekatan ini memperluas definisi materi riset
dari sekadar data formal menjadi spektrum masukan informal dan multimodal. Ini
menunjukkan bahwa alat Al seperti NotebookLM tidak hanya memproses data
terstruktur tetapi juga mampu memperoleh nilai dari beragam jenis input, yang
pada gilirannya memperluas cakupan materi yang dapat dianggap sebagai "riset”
bagi penulis.

e Memanfaatkan Tipe Konten Multimodal: Kekuatan NotebookLM terletak pada
kapasitasnya untuk memproses berbagai format konten. Untuk sintesis riset, ini
berarti mengumpulkan laporan resmi, studi akademis, laporan industri, bab buku,
postingan blog, video YouTube, dan tautan situs web." Kemampuan ini
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memungkinkan penulis untuk mengintegrasikan informasi dari berbagai sumber,
baik teks, audio, maupun visual, ke dalam satu basis pengetahuan yang kohesif.
Memanfaatkan Alat untuk Pengumpulan Konten Massal: Untuk analisis
kompetitif yang melibatkan volume konten besar, alat pendukung seperti Apify
dapat berperan krusial. Apify memungkinkan pengguna untuk secara efisien
mengumpulkan banyak tautan YouTube atau sumber konten lainnya secara
massal, secara signifikan mengurangi pekerjaan manual.’

Mempertimbangkan Kapasitas Sumber: Fitur NotebookLM mendukung
kapasitas yang besar untuk sumber. Paket gratis NotebookLM dapat menampung
hingga 50 sumber per notebook, sementara versi premium (untuk pengguna
Google Workspace) memperluas kapasitas ini hingga 300 sumber." Alokasi yang
besar ini memungkinkan cakupan topik yang menyeluruh dalam satu ruang kerja,
memastikan bahwa penulis memiliki akses ke semua data yang relevan tanpa
batasan yang signifikan.

3. Mengunggah Referensi ke NotebookLM

Setelah referensi terkumpul, langkah selanjutnya adalah mengunggahnya ke
NotebookLM. Proses ini mengubah NotebookLM menjadi ahli Al yang dipersonalisasi
dalam informasi yang paling penting bagi penulis.’

Fitur utama NotebookLM yang mendukung proses ini meliputi:

Dukungan Format Beragam: Penulis dapat mengunggah PDF, situs web, video
YouTube, file audio, Google Docs, atau Google Slides.? NotebookLM akan secara
otomatis meringkasnya dan membuat koneksi menarik antar topik, didukung oleh
kemampuan pemahaman multimodal Gemini 2.0.° Ini berarti NotebookLM dapat
memahami konten video melalui subtitle, deskripsi, dan transkrip, serta
menganalisis teks dari rekaman suara setelah transkripsi.

Asisten Riset Virtual: Setelah semua sumber dimuat, NotebookLM berfungsi
sebagai asisten riset virtual yang mampu menjawab pertanyaan atau melacak
referensi berdasarkan seluruh materi sumber yang telah disediakan.? Ini
menghemat waktu berjam-jam untuk membaca ulang, menyoroti, dan mencari.
Respons Berbasis Sumber dengan Kutipan: Salah satu fitur yang paling
penting adalah kemampuan NotebookLM untuk memberikan kutipan yang jelas
untuk setiap responsnya, menunjukkan kutipan persis dari sumber asli.? Ini secara
fundamental mengatasi kekhawatiran umum tentang "halusinasi" Al dan
meningkatkan kepercayaan terhadap informasi yang dihasilkan. Arsitektur ini
menjadikan NotebookLM sebagai basis pengetahuan internal yang dapat
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diandalkan, memungkinkan penulis untuk membangun narasi mereka dengan
keyakinan pada fondasi data yang terverifikasi dan dikendalikan pengguna.
Kemampuan untuk "melihat sumber, bukan hanya jawaban" ? menumbuhkan
tingkat kepercayaan baru pada informasi yang dihasilkan Al, menjadikannya alat
yang sangat diperlukan untuk menjaga akurasi faktual dalam konten berdurasi
panjang.

Fitur Organisasi dan Visualisasi: NotebookLM mencakup fitur peta pikiran
interaktif yang mengubah catatan yang diunggah menjadi jaringan visual topik
dan subtopik yang terhubung." Ini memberikan pandangan menyeluruh tentang
bagaimana semua bagian riset saling terkait, sangat membantu dalam
menguraikan plot yang kompleks, membangun busur karakter, atau menyusun
buku nonfiksi.? Selain itu, fitur "Audio Overview" dapat mengubah sumber menjadi
diskusi "Deep Dive" yang menarik dengan satu klik, memungkinkan penulis untuk
mendengarkan dan belajar saat bepergian.?

4. Membuat Draf Awal dengan NotebookLM

Meskipun NotebookLM adalah alat yang sangat kuat untuk riset dan organisasi,
perannya dalam pembuatan draf awal lebih fokus pada penyusunan kerangka dan ide,
bukan generasi konten bab secara penuh. NotebookLM dirancang untuk
mengorganisir riset, meringkas informasi, dan menghasilkan kerangka serta ide, bukan
membuat konten bab secara lengkap.?

Kemampuan NotebookLM dalam fase ini meliputi:

Penyusunan Kerangka dan Ide: Dengan semua materi riset yang dimuat,
NotebookLM dapat membantu menyusun kerangka presentasi yang terstruktur,
lengkap dengan poin-poin penting dan bukti pendukung.’ Fitur peta pikiran
interaktifnya sangat membantu dalam menguraikan plot yang kompleks,
membangun busur karakter, atau memetakan struktur buku nonfiksi.? Ini
memungkinkan penulis untuk memvisualisasikan koneksi antar sumber dan
mengidentifikasi pola atau inkonsistensi yang mungkin tidak terlihat sebelumnya.’
Identifikasi Pola dan Inkonsistensi: NotebookLM dapat membantu penulis
menemukan pola dalam cerita yang tidak mereka sadari, menangkap inkonsistensi
sebelum menjadi masalah, dan bahkan membantu penulisan ulang berdasarkan
gaya dan catatan penulis sendiri.?

Penyelesaian Masalah Kreatif: Alat ini juga dapat membantu memecahkan
masalah kreatif dengan menyarankan karakter yang menarik atau plot twist untuk
penulisan novel atau pembangunan dunia.?



Pembatasan NotebookLM pada tahap ini adalah bahwa ia tidak secara langsung
menghasilkan konten naratif atau ekspositori lengkap untuk bab-bab. Fungsinya
adalah sebagai asisten riset yang canggih dan generator ide, bukan penulis konten
penuh untuk bab-bab ekstensif.? Hal ini menunjukkan bahwa fase penyusunan draf
awal merupakan upaya kolaboratif di mana NotebookLM menyediakan kerangka dasar
dan pemahaman awal, sementara penulis atau alat Al berikutnya seperti Gemini
bertanggung jawab untuk pengembangan narasi dan eksposisi yang lebih detail.
Pembagian kerja ini mengoptimalkan proses penulisan dengan memanfaatkan
kekuatan spesifik masing-masing alat.

Bagian 2: Pengembangan dan Penyempurnaan Konten dengan
Gemini

5. Melanjutkan ke Gemini untuk Pengembangan Lebih Lanjut

Setelah kerangka dan ide awal terbentuk di NotebookLM, langkah selanjutnya adalah
beralih ke Gemini untuk pengembangan dan penyempurnaan konten yang lebih
mendalam. Gemini, khususnya melalui fitur "Help me write" di Google Docs, adalah
alat yang ideal untuk memperluas, menyempurnakan, dan menghasilkan konten
bentuk panjang dari awal atau dari kerangka yang sudah ada.®

Perbedaan utama antara NotebookLM dan Gemini dalam konteks ini adalah fokusnya.
Sementara NotebookLM unggul dalam riset berbasis sumber yang terkurasi dan
terinternalisasi, Gemini memiliki kemampuan generatif yang lebih luas, mampu
menarik dari kumpulan data yang lebih ekstensif untuk mengembangkan ide menjadi
narasi yang kohesif.'® Ini memungkinkan penulis untuk mengambil kerangka yang
dihasilkan NotebookLM dan mengisinya dengan detail, narasi, dan analisis yang lebih
kaya.

6. Menyempurnakan dengan Prompt di Gemini

Penyempurnaan teks dengan Gemini melibatkan penggunaan prompt yang spesifik
dan terstruktur untuk memandu Al agar menghasilkan output yang diinginkan.
Pendekatan "prompt chaining" sangat efektif dalam hal ini, karena memungkinkan
penulis untuk memecah tugas kompleks menjadi langkah-langkah yang lebih kecil dan
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berurutan.”

e Menulis Ulang Teks: Gemini di Google Docs dapat membantu menulis ulang teks
yang ada. Penulis dapat memilih teks dan menggunakan opsi "Help me write"
untuk "Rephrase" (menulis ulang), "Shorten" (memperpendek), "Elaborate"
(memperjelas), "More formal" (lebih formal), "More casual" (lebih santai),
"Bulletize" (membuat daftar poin), atau "Summarize" (meringkas).® Ini memberikan
fleksibilitas untuk menyesuaikan gaya dan nada sesuai kebutuhan bab atau
bagian tertentu.

e Menambahkan Detail & Contoh: Untuk memperkaya konten, penulis dapat
menggunakan prompt eksplisit untuk meminta Gemini menambahkan detail lebih
lanjut atau contoh spesifik. Misalnya, prompt dapat berbunyi: "Perluas paragraf ini
dengan menambahkan tiga contoh konkret yang menggambarkan [konsep].
Pastikan untuk menyertakan detail sensorik."."

e Memastikan Kohesi: Meskipun tidak ada prompt tunggal yang secara eksplisit
meminta "memastikan kohesi," pendekatan prompt chaining secara intrinsik
mendorong kohesi. Dengan membangun narasi secara bertahap, di mana output
dari satu prompt menjadi dasar untuk prompt berikutnya, Gemini dapat
mempertahankan konsistensi dan menghasilkan hasil yang koheren." Ini mirip
dengan proses editor manusia yang secara iteratif menyempurnakan teks.

Strategi "prompt chaining" dengan Gemini bukan sekadar metode untuk dekomposisi
tugas, melainkan pendekatan yang canggih untuk penyempurnaan konten secara
iteratif yang mencerminkan proses bernuansa editor manusia. Dengan membagi tugas
penulisan yang kompleks menjadi serangkaian prompt yang lebih kecil dan saling
terkait, penulis dapat memandu Gemini dengan presisi yang luar biasa, sehingga
menghasilkan output yang tidak hanya berkualitas lebih tinggi tetapi juga lebih kohesif
dan tidak generik. Hal ini menunjukkan bahwa penguasaan rekayasa prompt
berkembang menjadi keterampilan mendasar bagi penulis yang ingin memaksimalkan
penggunaan Al dalam proses kreatif mereka, beralih dari permintaan sederhana ke
interaksi strategis multi-langkah yang secara efektif "melatih” Al menuju hasil yang
diinginkan.

Berikut adalah tabel contoh prompt efektif untuk pengembangan dan penyempurnaan
teks di Gemini:



Tabel 1: Contoh Prompt Efektif untuk Pengembangan dan Penyempurnaan Teks
di Gemini’. Memilih Fitur Deep Research Gemini (Opsional namun
Direkomendasikan)

Tujuan Contoh Prompt

Generasi Draf Awal "Tulis draf bab tentang [topik] dengan fokus
pada [sudut pandang]. Sertakan pengantar,
tiga sub-bagian utama, dan kesimpulan
singkat. Target 500 kata."

Ekspansi & Detail "Perluas paragraf ini dengan menambahkan
tiga contoh konkret yang menggambarkan
[konsep]. Pastikan untuk menyertakan detail
sensorik."

Refinement Gaya & Nada "Tulis ulang bagian ini agar nadanya lebih
akademis dan formal, hilangkan bahasa
sehari-hari." atau "Buat bagian ini lebih ringkas
dan langsung ke intinya."

Ringkasan & Poin Kunci "Ringkas bab ini menjadi 150 kata, fokus pada
tiga poin kunci utama."

Memastikan Kohesi "Tinjau transisi antara paragraf [X] dan.
Sarankan cara untuk membuatnya mengalir
lebih mulus." atau "Baca seluruh draf bab ini
dan identifikasi area di mana argumen dapat
diperkuat atau diperjelas.”

Fitur Deep Research Gemini adalah alat bertenaga Al canggih yang dirancang untuk
menganalisis, mensintesis, dan menghasilkan output riset berkualitas tinggi dengan
menarik dari kumpulan data ekstensif dan mengidentifikasi tren.” Meskipun
NotebookLM menyediakan basis pengetahuan internal yang kuat, Deep Research
Gemini berfungsi sebagai lapisan validasi eksternal dan perluasan.



Kapan dan Mengapa Menggunakan Deep Research:

Riset Mendalam: Deep Research ideal untuk riset akademis, bisnis, atau
profesional yang membutuhkan wawasan mendalam dengan sedikit usaha manual
dibandingkan mesin pencari tradisional.™

Validasi dan Perluasan Informasi: Gunakan fitur ini ketika diperlukan untuk
memvalidasi informasi yang ada, menambahkan data eksternal, atau menjelajahi
tren yang mungkin tidak tercakup dalam sumber pribadi yang diunggah ke
NotebookLM."” Ini sangat berguna untuk memastikan bahwa argumen didukung
oleh data yang luas dan terkini.

Strategi Prompt untuk Penelitian Mendalam dan Referensi Komprehensif:

Untuk mendapatkan hasil yang paling akurat dan relevan dari Deep Research Gemini,
penting untuk menyusun prompt secara efektif:

Jelas dan Spesifik: Prompt harus secara eksplisit mendefinisikan cakupan riset
(geografis, temporal, tematik) dan jenis informasi yang dicari (fakta, tren,
perbandingan, studi kasus).” Misalnya, daripada "Ceritakan tentang perubahan
iklim," lebih baik "Analisis dampak kenaikan permukaan air laut terhadap
komunitas pesisir dalam 50 tahun ke depan, fokus pada gangguan ekonomi dan
sosial. Sertakan contoh spesifik wilayah yang terkena dampak."."

Struktur Prompt: Gunakan poin-poin, daftar bernomor, atau sub-judul untuk
mengorganisir prompt dan format output yang diharapkan.™ Ini membantu Gemini
memahami alur pemikiran dan menyajikan informasi dengan cara yang terstruktur.
Format Output yang Diinginkan: Sangat penting untuk menentukan format
kutipan (misalnya, gaya APA, MLA, Chicago) dan struktur laporan yang diinginkan
(ringkasan eksekutif, pendahuluan, isi, kesimpulan), termasuk jumlah kata untuk
setiap bagian.”” Deep Research dirancang untuk menyediakan kutipan, dan
meminta format tertentu akan memastikan konsistensi.

Berikan Konteks & Latar Belakang: Sertakan definisi terminologi khusus atau
ringkasan singkat tentang pengetahuan saat ini tentang topik tersebut. Jika ada
sudut pandang atau perspektif tertentu yang diminati, sebutkan secara eksplisit.™
Iterasi dan Perbaikan: Riset jarang merupakan proses satu kali. Penulis harus
siap untuk menyempurnakan prompt berdasarkan hasil awal, menambahkan
detail, mengubah pertanyaan, atau mengubah format output yang diinginkan."
Fokus pada Analisis & Sintesis: Dorong Gemini untuk melampaui pengambilan
informasi. Minta Gemini untuk membandingkan dan mengontraskan sumber yang
berbeda, mengidentifikasi pola dan tren, menarik kesimpulan, membuat inferensi,
dan mengevaluasi informasi secara kritis."

Pertimbangkan Batasan: Tentukan batasan waktu (misalnya, "studi yang

8



diterbitkan dalam 5 tahun terakhir") atau batasan geografis (misalnya, "fokus
pada analisis yang mempertimbangkan ekonomi maju dan berkembang"). Penulis
juga dapat meminta jumlah minimum sumber yang berbeda."

Contoh prompt Deep Research yang komprehensif:

e Topik Riset: "Dampak kecerdasan buatan pada pasar kerja dalam 10 tahun ke
depan.”

e Output yang Diinginkan: "Laporan riset (sekitar 1.500 kata) dengan struktur
berikut: Ringkasan Eksekutif (150 kata), Pendahuluan (250 kata), Dampak pada
Sektor Berbeda (500 kata), Implikasi Sosial dan Ekonomi (400 kata), dan
Kesimpulan (200 kata)."

e Format Kutipan: "Gaya APA. Sertakan kutipan dalam teks dan bibliografi di akhir
laporan.”

e Fokus Spesifik: "Fokus pada studi dan laporan yang diterbitkan dalam 5 tahun
terakhir. Berikan perhatian khusus pada analisis yang mempertimbangkan
ekonomi maju dan berkembang. Sertakan setidaknya 5 sumber berbeda.".”

Kemampuan Deep Research Gemini, dengan kemampuannya yang eksplisit untuk
menyediakan kutipan dan mensintesis informasi dari "kumpulan data ekstensif" ',
berfungsi sebagai lapisan validasi dan perluasan eksternal yang kuat terhadap riset
internal berbasis sumber yang dilakukan di NotebookLM. Pendekatan riset dua lapis
ini—menggabungkan penyelaman mendalam internal dengan sumber yang dikurasi
melalui NotebookLM dan investigasi eksternal yang luas dan otoritatif menggunakan
Gemini—memungkinkan penulis untuk membangun basis pengetahuan yang sangat
kredibel dan komprehensif. Ini memastikan bahwa karya yang dihasilkan memperoleh
manfaat dari kedalaman granular yang berasal dari materi spesifik yang dikurasi
sendiri oleh penulis, serta keluasan yang disediakan oleh berbagai data yang
bersumber dari internet dan memiliki keakuratan akademis.

Bagian 3: Finalisasi dan Persiapan Publikasi

8. Mengekspor ke Google Docs: Lingkungan Kolaborasi dan Penyuntingan

Setelah draf awal dan pengembangan konten selesai dengan bantuan NotebookLM
dan Gemini, naskah dapat dipindahkan ke Google Docs untuk proses penyuntingan
dan kolaborasi yang lebih mendalam. Google Docs adalah platform yang sangat baik
untuk menulis, mengedit, dan berkolaborasi.”



Manfaat Google Docs untuk penulisan buku meliputi:

e Akses Offline: Fitur "offline access" memungkinkan penulis untuk terus bekerja
pada draf mereka di mana saja, bahkan tanpa koneksi internet.” Fleksibilitas ini
memastikan produktivitas tidak terhambat oleh ketersediaan jaringan.

e Organisasi Naskah: Penggunaan "headings" dan "document outline" sangat
membantu dalam mengatur naskah yang panjang, meningkatkan kejelasan mental
bagi penulis dan kemudahan membaca bagi kolaborator.” Manajer Produk Docs,
Rebecca Hsieh, menyarankan penggunaan heading untuk memecah "dinding
teks" yang masif dan menambahkan daftar isi untuk dokumen yang lebih dari
empat halaman.”

e Pelacakan Kemajuan: Fitur "Display word count while typing" dapat menjadi alat
motivasi yang hebat untuk tantangan menulis, membantu penulis melacak jumlah
kata, karakter, atau halaman saat mereka mengetik."

e Efisiensi Penulisan: "Voice typing" dapat membuat tulisan terasa lebih
percakapan dan memberikan istirahat bagi tangan penulis.”® Meskipun
memerlukan pemeriksaan ejaan dan tata bahasa setelahnya, fitur ini dapat
mempercepat proses penulisan awal.

Meskipun tidak ada integrasi langsung yang disebutkan untuk draf bab penuh dari
NotebookLM ke Google Docs, output Al dari NotebookLM dan Gemini dapat dengan
mudah disalin dan ditempelkan ke Google Docs. Penulis harus memastikan untuk
menyimpan dan meninjau secara berkala, meskipun Google Docs secara otomatis
menyimpan perubahan, memahami riwayat versi sangat penting untuk melacak
revisi.”” Google Docs berfungsi sebagai pusat "human-centric" untuk proses penulisan
dan penyuntingan kolaboratif yang sebenarnya, terlepas dari bantuan Al yang
canggih. Hal ini menunjukkan bahwa meskipun Al mempercepat generasi konten dan
riset, "pengerjaan” dan "pemolesan” akhir buku tetap merupakan upaya yang sangat
manusiawi, dengan Google Docs menyediakan lingkungan yang ideal untuk kolaborasi
manusia-Al ini. Penilaian penulis dan masukan kolaboratif tetap menjadi yang
terpenting dalam membentuk narasi akhir.

9. Mengunduh Dokumen: Persiapan untuk Langkah Selanjutnya

Setelah naskah selesai diedit dan disempurnakan di Google Docs, langkah selanjutnya

adalah mengunduhnya dalam format yang sesuai untuk persiapan publikasi. Google

Docs menawarkan berbagai opsi format unduhan, masing-masing dengan kegunaan

spesifik:

e PDF: Format ini ideal untuk menjaga tata letak dan format untuk pencetakan
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profesional.’” File PDF memastikan bahwa tampilan dokumen akan konsisten di
berbagai perangkat dan platform, menjaga integritas desain yang telah
ditetapkan.

e .docx: Format ini cocok untuk berbagi naskah dengan editor, proofreader, atau
kolaborator lain yang mungkin menggunakan Microsoft Word. Format.docx
memungkinkan mereka untuk dengan mudah membuat perubahan,
menambahkan komentar, dan melacak revisi.

e .epub: Ini adalah format standar untuk e-book, memastikan kompatibilitas
dengan sebagian besar pembaca e-book dan toko buku digital.”” Mengunduh
dalam format EPUB sangat penting untuk distribusi digital, karena format ini
memungkinkan teks untuk "reflow" atau menyesuaikan diri dengan ukuran layar
perangkat pembaca, memberikan pengalaman membaca yang optimal.

e Format Lain: Google Docs juga mendukung unduhan dalam format lain
seperti.odt,.rtf,.txt, dan.html, yang mungkin berguna untuk tujuan tertentu atau
kompatibilitas dengan perangkat lunak lain.

Kemampuan untuk mengunduh naskah dalam berbagai format ini sangat penting
untuk penerbitan multi-platform, baik untuk cetak maupun e-book. Langkah ini
memastikan bahwa naskah dapat beradaptasi dengan berbagai metode konsumsi,
mulai dari buku fisik hingga e-reader, sehingga memaksimalkan potensi jangkauannya
ke audiens yang beragam.

10. Penyuntingan Akhir dan Tata Letak (Opsional, untuk Cetak): Memastikan
Kualitas Profesional

Fase penyuntingan akhir dan tata letak adalah tahap krusial untuk memastikan
kualitas profesional dan kesiapan naskah untuk publikasi. Meskipun Al telah
membantu dalam generasi dan penyempurnaan konten, "pekerjaan nyata dimulai”
setelah draf awal selesai, yang melibatkan revisi untuk kejelasan, kohesi, dan alur
logis."

Proses Penyuntingan dan Proofreading yang Efektif di Google Docs:

e Penyuntingan Manusia: Fokus utama pada tahap ini adalah revisi manusia yang
cermat. Ini melibatkan pembacaan ulang naskah untuk memastikan ide-ide
diartikulasikan dengan jelas dan bab mengalir secara logis dari satu bagian ke
bagian berikutnya.

e Umpan Balik Kolaboratif: Manfaatkan fitur kolaborasi Google Docs untuk
mengumpulkan dan meninjau saran dan komentar dari pembaca beta atau
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kelompok penulis.” Fitur "Tasks" di sidebar Docs dapat digunakan untuk

memecah bab dan editan menjadi bagian-bagian yang dapat ditindaklanjuti,

bahkan dengan tenggat waktu.”

Riwayat Versi: Gunakan "version history" Google Docs untuk kembali ke draf

sebelumnya, menemukan informasi yang dihapus, atau melihat kemajuan

penulisan.” Ini memberikan jaring pengaman untuk eksperimen dan revisi

ekstensif.

Teknik Proofreading: Berbagai teknik proofreading dapat diterapkan untuk

menangkap kesalahan yang terlewatkan oleh pemeriksa tata bahasa otomatis:

o Jalankan pemeriksa ejaan dan tata bahasa sebagai langkah awal.™

o Buat daftar kesalahan umum pribadi dan cari mereka dalam dokumen."

o Periksa nama diri dan istilah khusus untuk memastikan ejaan yang benar."”

o Ubah font dan ukuran teks untuk melihat kesalahan baru yang mungkin
muncul karena perubahan tata letak visual."”

o Baca naskah dengan suara keras untuk menangkap kesalahan tata bahasa,
frasa yang canggung, atau alur yang tidak mulus."

o Ambil jeda dan baca mundur (kata per kata atau kalimat per kalimat) untuk
fokus pada akurasi individual daripada alur naratif."”

Panduan Dasar Tata Letak untuk Penerbitan (Ukuran Halaman, Margin, Gaya):

Untuk memastikan naskah siap cetak dan memiliki tampilan profesional, perhatikan
panduan tata letak berikut di Google Docs:

Pengaturan Dokumen: Atur ukuran halaman (misalnya, 6"x9" untuk buku
standar) dan margin yang sesuai (biasanya 1" di semua sisi) melalui menu "File >
Page setup".”

Penyisipan Bagian: Buat halaman judul, daftar isi, dan mulai setiap bab baru di
halaman terpisah menggunakan jeda halaman ("Insert > Break > Page break")."
Menerapkan Gaya: Gunakan gaya heading yang telah ditentukan (misalnya,
Heading 1 untuk judul bab) untuk konsistensi dalam ukuran font, jenis, dan spasi.
Atur gaya teks normal (font, ukuran, spasi baris, indentasi) dan terapkan ke
seluruh dokumen.™

Kustomisasi Font & Teks: Pilih font yang mudah dibaca (misalnya, Times New
Roman, Garamond) dan ukuran font yang sesuai (biasanya 11 atau 12 untuk teks
isi). Atur spasi baris (1.15 atau 1.5 umum untuk buku) dan indentasi baris pertama
untuk paragraf (0.5"), kecuali untuk paragraf pertama bab atau bagian."

Nomor Halaman, Header & Footer: Masukkan nomor halaman (biasanya di
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bagian bawah, dimulai dari bab pertama, tidak termasuk halaman judul dan daftar
isi) dan gunakan header/footer untuk informasi seperti judul buku, nama penulis,
atau judul bab.™

e Gambar & Grafik: Format gambar dengan benar (posisi, ukuran, teks bungkus)
dan tambahkan keterangan menggunakan ukuran font yang lebih kecil dan huruf
miring untuk memberikan konteks atau kredit."

e Alat Profesional: Pertimbangkan penggunaan alat seperti Reedsy Studio.” Ini
adalah aplikasi pemformatan buku online gratis yang secara otomatis menyusun
dan memformat buku untuk ekspor PDF siap cetak dan EPUB yang sempurna. Alat
ini menghilangkan kekhawatiran tentang kesalahan pemformatan dan memastikan
bahwa naskah akhir memenuhi standar industri untuk publikasi perdagangan.’™

Tahap penyuntingan dan pemformatan akhir, meskipun didukung oleh alat pemeriksa
tata bahasa yang diaktifkan Al, sebagian besar tetap merupakan proses yang
didorong oleh manusia. Tahap ini sangat bergantung pada umpan balik dari rekan
sejawat dan teknik proofreading manusia yang teliti. Hal ini menunjukkan bahwa
meskipun Al berfungsi sebagai asisten yang kuat dalam generasi konten, akuntabilitas
utama untuk kualitas karya, ekspresi yang bernuansa, dan presentasi profesional tetap
berada di tangan penulis dan kolaborator manusia mereka. Oleh karena itu, "manusia
dalam lingkaran" tetap merupakan komponen yang sangat diperlukan untuk
menghasilkan materi yang siap diterbitkan.

Kesimpulan: Masa Depan Penulisan Buku dengan Al

Integrasi NotebookLM dan Gemini telah merevolusi proses penulisan buku,
mengubahnya dari tugas yang menantang menjadi alur kerja yang lebih efisien dan
terstruktur. Alat-alat Al ini berfungsi sebagai asisten yang kuat, mendukung penulis
dari fase riset multimodal yang komprehensif hingga draf awal, pengembangan, dan
penyempurnaan konten. Manfaat utamanya meliputi efisiensi waktu yang signifikan,
peningkatan kualitas riset yang didasarkan pada sumber yang diverifikasi, dan
kemampuan untuk mengatasi hambatan penulis dengan cepat.

NotebookLM unggul sebagai pusat riset pribadi, memungkinkan penulis untuk
mengumpulkan dan mensintesis informasi dari berbagai format sumber dengan
jaminan keakuratan melalui kutipan langsung. Ini membangun fondasi pengetahuan
internal yang kuat dan dapat diandalkan. Sementara itu, Gemini, dengan kemampuan
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generatifnya yang lebih luas dan fitur Deep Research, melengkapi NotebookLM
dengan menyediakan alat untuk mengembangkan ide-ide menjadi narasi yang kohesif,
menyempurnakan gaya dan nada, dan melakukan riset eksternal yang otoritatif
dengan kutipan yang komprehensif. Pendekatan dua lapis ini memungkinkan penulis
untuk menciptakan karya yang tidak hanya didasarkan pada riset mendalam yang
dikurasi sendiri tetapi juga didukung oleh data eksternal yang luas dan terverifikasi.

Meskipun Al mempercepat proses generasi konten, Google Docs tetap menjadi
lingkungan kolaborasi dan penyuntingan sentral yang berpusat pada manusia. Di
sinilah penulis menerapkan penilaian kreatif mereka, berkolaborasi dengan pembaca
beta, dan melakukan penyuntingan serta proofreading akhir yang teliti. Tahap akhir ini,
yang sangat bergantung pada umpan balik manusia dan teknik proofreading manual,
menegaskan bahwa Al adalah asisten yang kuat tetapi tidak menggantikan sentuhan
kreatif, penilaian, dan upaya editorial akhir dari penulis.

Bagi penulis yang ingin memulai perjalanan ini, disarankan untuk memahami kekuatan
unik setiap alat dan bagaimana keduanya saling melengkapi. Bereksperimen dengan
prompt dan teknik chaining akan membantu menemukan alur kerja yang paling efektif.
Penting untuk selalu mengingat bahwa Al adalah asisten yang tangguh, tetapi
masukan kreatif, penilaian, dan upaya penyuntingan akhir penulis tetap tak
tergantikan. Peran Al sebagai "asisten" yang kuat, bukan pencipta otonom,
menunjukkan bahwa Al tidak menggantikan masukan kreatif penulis dan penilaian
editorial akhir. Hal ini memperkuat model alur kerja di mana penulis manusia
mempertahankan otoritas dan tanggung jawab tertinggi atas kualitas, orisinalitas, dan
pertimbangan etis karya tersebut. Dengan demikian, kepenulisan yang dibantu Al
yang berhasil membutuhkan operator manusia yang terampil yang memahami cara
memanfaatkan alat-alat ini sambil mempertahankan kendali kreatif dan editorial yang
kuat.

Karya yang dikutip

1. Advanced NotebookLM Use Cases You Can Apply Today - Social Media Examiner,
diakses Juli 31, 2025,
https://www.socialmediaexaminer.com/advanced-notebooklm-use-cases-you-ca
n-apply-today/

2. Google NotebookLM for Authors: Write Your Book Faster - DiggiNet, diakses Juli
31,2025,
https://www.digginet.com/self-publishing/google-notebookim-for-authors/

3. A Complete How-To Guide to NotebookLM - Learn Prompting, diakses Juli 31,

2025, https://learnprompting.org/blog/notebooklm-guide

14


https://www.socialmediaexaminer.com/advanced-notebooklm-use-cases-you-can-apply-today/
https://www.socialmediaexaminer.com/advanced-notebooklm-use-cases-you-can-apply-today/
https://www.digginet.com/self-publishing/google-notebooklm-for-authors/
https://learnprompting.org/blog/notebooklm-guide

10.

1.

12.

13.

14.

15.

16.

17.

How To Use NotebookLM As A Research Tool | by Steven Johnson -
stevenberlinjohnson, diakses Juli 31, 2025,
https://stevenberlinjohnson.com/how-to-use-notebooklm-as-a-research-tool-éa
d5c3a227cc

Google NotebookLM | Al Research Tool & Thinking Partner, diakses Juli 31, 2025,
https://notebooklm.google/

| started using NotebookLM with Microsoft Word and I'm not going back - XDA
Developers, diakses Juli 31, 2025,
https://www.xda-developers.com/started-using-notebooklm-with-microsoft-wor
d/

NotebookLM for Beginners - Medium, diakses Juli 31, 2025,
https://medium.com/@leathomasx/notebookim-for-beginners-492d3c3c78da
Write with Gemini in Google Docs, diakses Juli 31, 2025,
https://support.google.com/docs/answer/13951448?hl=en

Writing Content with Al | Google Workspace, diakses Juli 31, 2025,
https://workspace.google.com/resources/ai-writing/

Is there a Way to Integrate Gemini 2.0 with NotebookLM? - Reddit, diakses Juli 31,
2025,

https://www.reddit.com/r/notebooklm/comments/1jSimwp/is_there_a_way to_inte
grate_gemini_20_with/

Prompt Chaining: Your Gemini Power-Up for Mastering Complex ..., diakses Juli
31,2025,
https://leonnicholls.medium.com/prompt-chaining-your-gemini-power-up-for-m
astering-complex-tasks-8f373614692f

How to Write a Deep Research Prompt for Gemini 1.5: Best ..., diakses Juli 31,
2025, https://7minute.ai/deep-research-prompt-for-gemini/

8 tips for writing a novel in Google Docs - Google Blog, diakses Juli 31, 2025,
https://blog.google/products/docs/writing-a-novel-in-google-docs/

Formatting Your Book in Google Docs: A Comprehensive Guide, diakses Juli 31,
2025,
https://miltonandhugo.com/blog/post/formatting-your-book-google-docs-compr
ehensive-gquide

Reedsy Studio: A FREE Online Book Formatting App, diakses Juli 31, 2025,
https://reedsy.com/studio/format-a-book

How to Structure a Book Chapter That Stands Out: Tips for Writing Engaging &
Academically Sound Chapters? - CARI Journals, diakses Juli 31, 2025,
https://carijournals.org/how-to-structure-a-book-chapter-that-stands-out-tips-f

or-writing-engaging-academically-sound-chapters/
A Simple Proofreading Guide to Keep Your Work Flawless (Al Included) -
Wordtune, diakses Juli 31, 2025,

https://www.wordtune.com/blog/proofreading-tips

15


https://stevenberlinjohnson.com/how-to-use-notebooklm-as-a-research-tool-6ad5c3a227cc
https://stevenberlinjohnson.com/how-to-use-notebooklm-as-a-research-tool-6ad5c3a227cc
https://notebooklm.google/
https://www.xda-developers.com/started-using-notebooklm-with-microsoft-word/
https://www.xda-developers.com/started-using-notebooklm-with-microsoft-word/
https://medium.com/@leathomasx/notebooklm-for-beginners-492d3c3c78da
https://support.google.com/docs/answer/13951448?hl=en
https://workspace.google.com/resources/ai-writing/
https://www.reddit.com/r/notebooklm/comments/1j5lmwp/is_there_a_way_to_integrate_gemini_20_with/
https://www.reddit.com/r/notebooklm/comments/1j5lmwp/is_there_a_way_to_integrate_gemini_20_with/
https://leonnicholls.medium.com/prompt-chaining-your-gemini-power-up-for-mastering-complex-tasks-8f373614692f
https://leonnicholls.medium.com/prompt-chaining-your-gemini-power-up-for-mastering-complex-tasks-8f373614692f
https://7minute.ai/deep-research-prompt-for-gemini/
https://blog.google/products/docs/writing-a-novel-in-google-docs/
https://miltonandhugo.com/blog/post/formatting-your-book-google-docs-comprehensive-guide
https://miltonandhugo.com/blog/post/formatting-your-book-google-docs-comprehensive-guide
https://reedsy.com/studio/format-a-book
https://carijournals.org/how-to-structure-a-book-chapter-that-stands-out-tips-for-writing-engaging-academically-sound-chapters/
https://carijournals.org/how-to-structure-a-book-chapter-that-stands-out-tips-for-writing-engaging-academically-sound-chapters/
https://www.wordtune.com/blog/proofreading-tips

	Langkah-Langkah Komprehensif Menyusun Buku Menggunakan NotebookLM dan Gemini 
	Bagian 1: Fondasi Riset dengan NotebookLM 
	1. Menentukan Judul atau Tema 
	2. Mengumpulkan Referensi 
	3. Mengunggah Referensi ke NotebookLM 
	4. Membuat Draf Awal dengan NotebookLM 

	Bagian 2: Pengembangan dan Penyempurnaan Konten dengan Gemini 
	5. Melanjutkan ke Gemini untuk Pengembangan Lebih Lanjut 
	6. Menyempurnakan dengan Prompt di Gemini 

	 
	Bagian 3: Finalisasi dan Persiapan Publikasi 
	8. Mengekspor ke Google Docs: Lingkungan Kolaborasi dan Penyuntingan 
	9. Mengunduh Dokumen: Persiapan untuk Langkah Selanjutnya 
	10. Penyuntingan Akhir dan Tata Letak (Opsional, untuk Cetak): Memastikan Kualitas Profesional 

	Kesimpulan: Masa Depan Penulisan Buku dengan AI 
	 
	Karya yang dikutip 



